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appy New Year 2018!

Every technology has its own language. Photography certainly does. When
people start changing traditional ways of expressing photographic concepts, I
get annoyed. For example, instead of referring to the orientation of photographs
as vertical and horizontal, many people now say portrait and landscape, respec-
tively. Why the change? It’s ridiculous, actually, since portraits can be taken
with a horizontal composition (like the one of my dogs and me above) and land-
scape images can be taken vertically (like the winterscape on the previous page).

I also get annoyed -- and confused -- when amateur photographers say “I used
a higher number” referring to a smaller lens aperture. Yes, a small f/stop has a
higher numerical value, but the correct terminology is, “I closed down” or “I
stopped down”. For large lens apertures, instead of “I used a bigger number”, it’s
more correct to say “I shot wide open” or “I opened up to /5.6

During midday when the sun is out, people often say it’s too “bright” for good
picture taking. It’s not the brightness that makes photos bad at midday, it’s the
contrast and the direction of light. It’s more correct to say the light is harsh or
contrasty. That is more to the point.

Jim Zuckerman
www.jimzuckerman.com
photos@jimzuckerman.com



PHOTOGRAPHY SOLUTIONS

saving a bad image

ackgrounds are just as important

as subjects in making a picture

successful. If the background is
distracting in some way, the picture will be a
failure even if the subject is great. An example
of this is the image below. I shot this during a
Christmas parade in Puerto Rico, and it’s obvi-
ous that the background is terribly busy. The
onlookers, the white car, the markings on the
street, and the poles and tree trunks all detract
from the subject. It’s hard to fully appreciate
the subject’s wild costume because of all the vi-
sually annoying shapes and colors in the back-
ground. I think of this picture as a mess!

Compare this shot with the one on the next
page, and it’s immediately obvious that the
modified background makes all the dif-
ference. Now we can fully appreciate the
unique costume and the wild mask.

So many times the character of the back-
ground we capture behind a subject is
completely out of our control. That’s why I
feel it’s essential to know how to change or
replace a background to save an otherwise
excellent image. In order to do this, you
have to know how to make a perfect selec-
tion around the subject. This usually takes



more time than many people are willing to
invest in the project, but in the end the effort
is worth it. Once the selection is made, the
elements behind the subject can be replaced,
blurred, darkened, or otherwise modified so
the subject stands out. Then there is nothing
that takes our attention away from the subject
itself.

For the image below, I applied Filter > field
blur, and then I added Filter > blur > radial
blur (in the diolog box, I hit the zoom but-
ton). The result is that the messy and distract-
ing background has been transformed into an
abstraction that directs all of our attention ex-
actly where it should be: on the subject.

The power of Photoshop is having the ability
to apply an effect to one part of a picture while
another part remains unchanged. That’s ex-
actly what I did here. The secret is having the

ability to make precise selections.

Because of the multi-colored background, and
because of the nature of the mask, the only way
to separate, or select, the parade participant
from the background was by using the pen
tool in Photoshop. At first glance, most pho-
tographers, I think, would conclude that this
would take forever and they wouldn’t want to
spend the time. But why not? After spending
thousands of dollars on a computer, software,
camera equipment, and travel, why not devote
the time to make your pictures perfect? Why
would you spend so much money and not strive
for this goal?

There are three options you have in evaluating
your images: (1) Trash shots that aren’t perfect,
(2) show them to friends and family with excus-
es, or (3) spend the time to make the photographs
as good as they can be.




The pen tool is very simple to use if you apply it
as I explain it. Here are the steps:

1. Choose the pen tool in the tools palette. The
icon looks like an old-fashioned ink pen nub.

2. Enlarge the photo to 66% or 100% so you can
see the edge detail of the subject.

3. Lay down a series of dots, or anchor points,
along the edge of the subject. When you need
to move the photo to expose more of the edge,
hold down the space bar. It automatically turns
into the hand tool, and you can move the im-
age. Release the hand tool and then continue
laying down the anchor points.

4. If you make a mistake and want to delete
anchor points, you can (a) hold down the Com-
mand and Option keys on a Mac (or the alt and
control keys on a PC) and then press the ‘Z’ key

as many times as necessary to undo the vari-
ous anchor points (this is simply the multiple
undo method); (b) click and hold the pen tool
icon in the tools palette and you’ll see several
tools hiding beneath. Choose the pen minus
tool, click the points you want to eliminate, and
then resume with the original pen tool by first
clicking the last point you've retained, and then
continue laying down anchor points.

5. When the last anchor point touches the first
anchor point you laid down, you've completed
the circuit around the subject. This gives you a
path. Now choose the paths palette (if it’s not
open, go to Window > paths), and in the up-
per right corner there is a tiny icon. Click that
and you’ll see a pulldown submenu. Among
the choices, choose Make selection. In the dia-
log box that opens, select one pixel and hit OK.
The path has now been turned into a selection
complete with the ‘marching ants. §
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PANO-MIRRORS . . . with a TWIST

any intriguing composites can be

created by mirroring an image.

You end up with patterns and de-
signs completely unexpected, and if you like
creating surrealism, there is no easier pathway
than to mirror an image with itself.

If you mirror a horizontal photograph with it-
self, the result is akin to a panorama. It is very
long in relation to its height. You can also start
with a vertical picture, and when it's mirrored
with itself you can simply repeat that process
three or four times to create a panorama for-
mat. You end up with a very unique repeating
pattern (see photo on page 12).

Once the panorama mirror is created, you
can then add another element such as the frog,
below. With a mirrored image, the viewer ex-
pects perfect symmetry. When a single ele-
ment is added, that creates visual tension. At
first glance, it doesn’t make sense. That’s what

is so interesting about this technique.

Here is the step by step procedure for creating
pano-mirrors with horizontal pictures:

1. Open a horizontal photo in Photoshop,
choose Select > all and then Edit > copy. Now
the photo is in the clipboard.

Current Size: 57.1M
Width: 18.24 Inches

Height: 12.16 Inches

New Size: 57.1M

Width: 18.24 Inches
Height: 12.16 Inches

| Relative

f/

o —»

v\

Canvas extension color: Background




2. Pull down the menu command Image > the background color box at the bottom of the
canvas size. In the dialog box on the previous tools palette. The color doesn’t matter at all. It
page, note the tic-tac-toe graphic. Use your will be covered up shortly.

cursor to click in the center left or center right
box (red arrow previous page). The box you
choose depends on which side of your photo
you want to create the mirror.

Then, in the width box, multiply that number
by 2 and type in the new width. Click OK. The 3. Choose Edit > paste. The clipboard shot
image doubles in width, and in the blank half  will be pasted into the center of the panorama.
the color you get is the same color you'll seein  This creates layer 1.

10



UPCOMING PHOTO WORKSHOPS

Carnival in Venice workshop

Outrageous costumes in a medieval en-
vironment! Venice is great to visit and
photograph any time, but during carnival
it's magical. There is nothing like it any-
where in the world. Exotic masks, stunning
colors, classic images.

Feb. 26 - March 4, 2019

Frog & Reptile Workshop

Close-up encounters with poison dart
frogs and exotic reptiles such as chame-
leons, geckos, snakes, and more in St.
Louis, Missouri. This is a macro work-
shop in which everyone consistently gets
amazing pictures.

March 24 - 25,2018

Photoshop workshop

The setting is in my home, and in this two
day workshop you’ll learn enough to be
truly dangerous in Photoshop! How to
replace a sky, how to fix all kinds of photo-
graphic problems in your pictures, how to
handle blown highlights, how to be incred-
ibly creative . . . and more.

June 30 - July 1, 2018

11
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4. Choose Edit > transform >
flip horizontal. This command
flips only the layer horizontal-

ly.

5. Click on the move tool and
move the layer in the new area
you created such that the pho-
tograph is now mirrored on it-
self as you see above. Enlarge
the composite to 100% to make
sure the two halves are perfect-
ly aligned. If they need nudg-
ing, you can use the arrow keys
to do that.

6. Finally, flatten the image
with Image > flatten layer.

To create a repeating pat-
tern

1. Start with a vertical com-
position. In the example
here, you can see that the
original shot is simply a
backlit tree with hoarfrost.
Note how many diagonal
lines there are. Diagonals
usually end up producing
amazing patterns.

2. Make a mirror image as
described on pages 9 and 10.
You can make the mirror ei-
ther on the right side or the
left side. The two possibili-

ties are shown below. For the
pattern, it doesn’t make any dif-

12



ference which one you start with.

3. Flatten the image with Image > flatten image
in the pull down menus.

4. Choose Select > all, then Edit > copy. Now
the mirrored image is in the clipboard. Consider
this the original photo now, and mirror it again
using the same procedure as on page 10. When
you are finished, you’ll have four reproductions
of the first picture and the beginning of the re-
peating pattern.

5. Click Layer > flatten image.

6. Put the entire 4-image pattern into the clip-
board with Select > all and Edit > copy.

7. Now select Image > canvas size. This time,
however, in the tic-tac-toe graphic you see in the
dialog box, choose the top center box (green ar-
row, upper right) and then double the number in
the height field (red arrow). Click OK.

8. The expanded ‘canvas’ is now at the bottom of
the image instead of to the right or left. Choose
Edit > paste. The clipboard image becomes layer
1. Use the move tool to move it into place which
then mirrors the top portion of the image.

Canvas Size

Current Size: 240.6M
Width: 49.92 Inches

( ok )

Cancel

Height: 18.72 Inches

New Size: 240.6M

Width: 49.92 Inches
Height: 18.72 Inches
Relative

. |

Canvas extension color: Background

9. Select Edit > transform > vertical. The
repeating pattern should now be complete.

10. You can continue this proces to expand
the pattern in any direction.

Adding the twist

Adding the additional non-mirrored compo-
nent introduces an unexpected element since
everything else is mirrored. Once the back-
ground image is complete, simply select the
new subject with one of the selection tools
and then use Edit > paste. With the move
tool, you can move it into place and then fur-
ther tweak the composite if necessary. For
example, you might want to add a drop shad-
ow or reflection. §
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STAR PHOTOGRAPHY

Anp NOISE

hotographing the night sky, specit-

ically the beautiful Milky Way, is a

challenge on several levels. One of
the most important aspects of sky photography
is noise.

Because of the rotation of the Earth, a relatively
short shutter speed is required to capture the
night sky without star trails. Some photogra-
phers love streaks of light in a night sky, but to
me this is no different than replacing the stars
and the Milky Way with any kind of abstrac-

tion. The mystery, the grandeur, and the sheer
beauty of the night sky can only be revealed
when everything is sharp.

Getting back to the technical aspects, a short
shutter speed means less light enters the cam-
era. To compensate for the reduced light, there
are two options: (1) Shoot with the largest ap-
erture possible, and/or (2) Raise the ISO. If the
largest aperture is already selected, then -- in
order to prevent star trails or even the begin-
ning of the trails (such that the stars look ob-




long), the ISO must increase. 6400 ISO, the unwanted noise will be obliter-
ated with stacking.
With increased ISO, though, noise increases.
This is particularly vexing because the subtle-  Here is the procedure in Photoshop to stack a
ties in color, tone, and detail in a starry sky can  series of shots.
only be revealed with minimum noise.
1. Take a series of 8 to 10 shots of the sky from a

So, what is the solution? tripod in RAW mode. Isuggest using no more
than 20 seconds for the exposure, and less time
Stacking is better to prevent oblong-shaped stars. I pre-

fer tungsten white balance because that makes
The term Stacking refers to taking several pic-  the sky look bluish instead of brownish, which
tures of the same scene from
a tripod and then combin-
ing them using a few short
steps in Photoshop. The ra-
tionale for doing this is that
noise is random, and when
several images are stacked
together the software does
two things: First, it aligns
the images. If there is move-
ment, particularly uniform
movement such as the stars
moving across the sky due
to the Earth’s rotation, all of
the stars are aligned. Even
though the images were tak-
en over time, the final com-
posite appears as if it is a sin-
gle photo.

Second, the noise, which is
laid down in a random pat-
tern, disappears. Each image
in the composite has its own
pattern of noise, and it is this
randomness that makes it
possible for the noise to dis-
appear.

Even if you shoot as high as




is what you get when using daylight white bal-
ance.

2. In Bridge or Lightroom, highlight all the
frames you wish to stack. You do this by hold-
ing down the shift key and clicking on the first
sky shot and then the last sky image in the se-
quence.

3. Use the pull down menu command in
Bridge: Tools > Photoshop > Load Files into
Photoshop Layers.

In Lightroom, use the pulldown menu com-
mand: Photo > Edit in > Open as Layers in
Photoshop.

4. Photoshop is now active and you can see
the layers you just created in the layers palette.
Select all of the layers by holding down the
shift key and clicking each layer. At this point,

16

choose Edit > auto-align layers. In the dialog
box that opens, make sure the ‘auto’ button is
checked. Click OK.

You may need to crop the image slightly be-
cause when Photoshop aligns the images, the
edges of the frames may not line up.

5. Now select the pulldown menu command:
Layer > Smart Objects > Convert to Smart
Object.

6. Finally, choose: Layer > Smart Objects >
Stack mode > median (or mean).

Temperature

Another way to keep noise to a minimum is
with temperature. The colder the digital sensor
is, the less noise you'll have. If you photograph
the night sky in winter, for example, with sub-
freezing temperatures, the images will have less
noise.

The Milky Way is not visible from November
through mid-February. It reappears in late Feb-
ruary and March just before sunrise. For many
months during the winter, then, you can pho-
tograph the night sky with its billions of stars,
but the Milky Way will be hidden beneath the
horizon. When it finally shows itself starting
with a couple of hours in April (from 4am to
sunrise), it may not be that cold in your area.
If you live near mountains, drive to the high-
est point accessible by road. The temperature
should drop approximately 5.4 degrees Fahren-
heit per thousand feet of elevation gain (6.5 de-
grees Celsius per 1 kilometer). Another advan-
tage of shooting the stars from the mountains
is there shouldn’t be any light pollution from
nearby cities. You should also choose a night
of a new moon so the sky is totally dark except
for the stars. §
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The Problem with Cruises

your passion is photography and pic-

ture taking is your primary focus when

you travel, then dont go on a cruise.

I've only been on one cruise to the Caribbean

at the insistence of my wife. It was enjoyable,

relaxing, sort of fun, and definitely decadent.

Sitting in a jacuzzi on the top deck watching

a movie on a monster screen was a very cool

experience. Nevertheless, I was frustrated ev-

ery day because the picture taking opportuni-

ties were very limited. Even though I expected
this, it was still frustrating.

Virtually without exception, you go ashore
between 8 and 10am. You have to return by
4 or 5pm, and this means you miss both sun-

rise and sunset lighting. You are always fighting
harsh sunlight and too much contrast. When it
comes to shooting at twilight -- forget it. That’s
not going to happen because you must be back
on the ship which will then cruise to the next
port destination. When the lights of the city
come on and when the sky is cobalt blue, you
won't be there to photograph it.

If the ship interior is architecturally dramatic,
you can use it as a background for doing por-
traits of your family or friends, as I did with
my wife on the next page. There’s not much to
shoot besides that. Go on a cruise to relax, get
away from the office, and eat. Don't go thinking
you’ll come home with exciting photos. §
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CHINA

Dec. 29, 2018 - Jan. 8, 2019

The incredible Harbin Ice Festival = Siberian tigers in snow  Blue-faced monkeys

Siberian tigers in sub-zero cold, China.



http://www.jimzuckerman.com/indonesia-wildlife-culture-photo-tour
http://www.jimzuckerman.com/china-photo-tour-2018-2019
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took this picture during the remarkable Jember Fashion Carnaval in In-

donesia. To direct the attention to the costumed participant, I used the

burn tool to darken the pavement as well as the area of the onlookers. One
could argue that all the people in the background are distracting, and in terms of a
clean, artistic picture, I would agree. But this is a parade down a street with thou-
sands of spectators, so in that sense the crowd not only works but is appropriate.

The problem I see in this shot is the newspaper lying in the street at the middle left.
It is white and very graphic in its shape, and both of those factors make it distract-
ing. As you look at this picture, notice that your eyes automatically re-focus from
the subject to the newspaper. That’s not how a successful picture is supposed to



work. Our attention should primarily stay focused on the subject.

There is one more thing that bothers me as well. In the upper left corner, the
white fabric behind the spectators is distracting. The crowd as a dark backdrop
is ok, but those graphic shapes of the silhouetted people draw the eye away
from the young woman.

In the version above, I used a combination of the content aware feature (Edit
> fill; and then in the dialog that opens use the submenu to select ‘content
aware’) and the clone tool in Photoshop to eliminate the newspaper lying on
the ground as well as the paper adjacent to it. In addition, I used the clone tool
to eliminate the shapes of the people in the upper left corner. Now the pres-
ence of the crowd shows the parade as I saw it, but without the elements that
diverted the attention from the costumed participants. §
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1. Puppies can be manipulated into various positions
when they are very tired. They seem almost ‘punch
drunk’ To take this image, these Cavalier King Charles
spaniels were almost sleeping. I placed the head of one
on top of the other since they were completely out of it.

3. Great moments with wildlife are very fleeting.
You have to watch animal behavior through the view-
finder of your camera to catch it. If you observe ani-
mals with only your eyes and, when seeing something
photogenic you raise the camera to your eyes, it will
probably be too late.

2. Don't hesitate to compose pictures where the sub-
jectis dead-center. The Rule of Thirds works in many,
or even most, types of shots, but a central placement
also works in many situations. Sometimes, both types
of compositions look good.

4. This is what happens when you take a camera from
a warm room in your home or a hotel outdoors in the
cold. Moisture condenses on all the glass elements of
the lens, the viewfinder, and the mirror. Plan ahead.
Acclimate your equipment to the cold for at least 20
minutes before shooting. §
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ASK JIM

Every month Jim will answer a question from his online students, from people who participate
in his tours and workshops, or from subscribers to this magazine. If you have a question
youd like Jim to answer, please drop him a note at photos@jimzuckerman.com.

Q: Jim . . I took this shot of a moon jelly in the Atlanta aquarium, and when I enlarge this to 100% on my
computer, it doesn’t seem as sharp as I'd like. What do you think the problem might be?

Lynne Atkinson, Marietta, Georgia.

A: When photographing in an aquarium, sharpness is a function of two things: (1) The optical quality of
the glass or Lucite, which you can’t control, and (2) the angle between the lens axis and the front surface of the
aquarium. You can control the latter. Maximum sharpness is achieved when the lens axis is perpendicular,
i.e. 90 degrees, to the front of the aquarium. If you angle the camera such that the lens axis is oblique to the
glass or Lucite, the image degrades quickly. Of course, your shutter speed has to be fast enough to give you a
sharp picture as well. I would use a shutter speed at least 1/125, although 1/200 is better. The subject is usu-
ally moving plus you are hand holding the camera, so the fast shutter is necessary. §

(c) Lynne Atkinson
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Photography Tours
2017 - 2019

SOUTH AFRICA & NAMIBIA TUSCANY INDONESIA WILDLIFE
Apr. 2018 Jun. 2018 Aug. 2018

R

] P
L3

el

NORWAY & DENMARK THE PANTANAL, BRAZIL CHINA
Sep. 2018 Nov. 2018 Dec. 2018 - 2019

ETHIOPIA SNOWY OWLS ICELAND
Jan. 2019 Jan. 2019 Mar. 2019

SCOTLAND OREGON COAST UZBEKISTAN & KYRGYZSTAN
May 2019 Aug. 2019 Sept. 2019

For a complete list of all the photo tours/workshops Jim conducts, go to his website: www.jimzuckerman.com.
26
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Scotland Photo Tour
May 17 - May 27, 2019

awesome landscapes ancient ruins remarkable castles

The Old Man of Storr, Isle of Skye, Scotland

27
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Student Showcase

Each month, Jim features one student who took beautiful and inspiring images on one or more of his pho-
tography tours or workshops. It’s really fascinating how photographers see and compose such different im-
ages even though we may go to the same places. Everyone gets great photographs on Jim’s trips.

Carl Schneider, Hammond, Louisian Photo tours to: Turkey, Kenya, Costa Rica, Namibia, Botswa-
na, India, Tuscany/Cinque Terre, Japan, China, The Pantanal, Holland/Belgium, Burma, and more.

© 2018 Carl Schneider
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Student Showcase, continued

© 2018 Carl Schneider
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Student Showcase, continued

A

© 2018 Carl Schneider
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Student Showcase, continued

-
3

Ny % A

© 2018 Carl Schneider

31



WILD INDONESIA PHOTO TOUR

27 - 31, 2018



http://www.jimzuckerman.com/indonesia-wildlife-culture-photo-tour

PHOTOSHOP WORKSHOP

Imn ms HOME

Sat. & Sun., June 30 - July 1, 2018

Photoshop is a photographer’s best friend, and the creative possi-
bilities are absolutely endless. In a personal and ‘homey’ environ-
ment (I have a very cool classroom setup in my home), I start at
the beginning -- assuming you know nothing -- but I quickly get
into layers, cutting and pasting, plug-ins, using ‘grunge’ textures,
replacing backgrounds, using layer masks, blend modes, adding a
moon, and a lot more. I promise to fill your head with so many
great techniques that you won't believe what you’ll be able to do. I
go over each technique several times to make sure you understand
it and can remember it.

Photoshop instructors approach teaching this program from dif-
ferent points of view. My approach is to be as expansive in my
thinking as possible in creating unique, artistic, and compelling
images. In addition to showing you how to use the various tools,
pulldown menus, layers, and so on, I spend a lot of time giving you

creative ideas that will inspire you to produce amazing images with
the pictures you've already taken.

Ilive in the Nashville, Tennessee area, and if you fly into the airport
(BNA) I will pick you up. If you drive, I'll give you my address and
you can find my home on Mapquest or with a GPS. For the $450
fee, I include one dinner in my home (prepared by my wife who is
an amazing cook and hostess) and two lunches, plus shuttling you
back and forth from my home to your nearby hotel.

Contact me if you would like to participate in the workshop and
I will tell you how to sign up (photos@jimzuckerman.com). All
you need is a laptop and a lot of your pictures. If you don’t have
a laptop, I have two Mac Book Pro laptops I can loan out for the

duration of the workshop. N
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